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[bookmark: _Toc1485]Chapter 1 A basic introduction to machines
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[bookmark: _Toc121286244][bookmark: _Toc146004277][bookmark: _Toc121286553][bookmark: _Toc121286670][bookmark: _Toc121285952][bookmark: _Toc146004486][bookmark: _Toc26224]Ⅱ Main parameter

	Seq.
	Item
	Index

	1
	Working power supply
	DC: voltage 12V + 10% current < 350mA

	2
	Outer size
	200(L) x88(W) x 28(D) mm

	3
	Weight
	0.28kg

	4
	working temperature
	-20℃—50℃

	5
	Humidity
	10%—85%

	6
	Storage capacity
	60000 records, 500 faces, 1500 fingerprints and 500 passwords.

	7
	Speed of recognition
	≤0.5S

	8
	FRR
	<0.01%

	9
	FAR
	<0.001%

	10
	Communication mode
	TCP/IP, & U-disk
Via U-disk it can send fingerprint data to other devices

	11
	Wiegand signal
	Wiegand output, can be used as a reader

	12
	Keyboard and display
	2.8 inch color screen and touch button
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[bookmark: _Toc17716][bookmark: _Toc121286271][bookmark: _Toc146004302][bookmark: _Toc121286580][bookmark: _Toc146004511][bookmark: _Toc70154857][bookmark: _Toc121286695][bookmark: _Toc121285979]Chapter 2  Instructions of the machine
Under attendance status, press the "MENU" key
(1) Once the manager has not been registered, directly into the menu;
(2) The registered manager can enter the menu after successful verification.
[bookmark: _Toc70154858][bookmark: _Toc146004303][bookmark: _Toc146004512][bookmark: _Toc121285980][bookmark: _Toc121286581][bookmark: _Toc121286696][bookmark: _Toc121286272] Ⅰ			Register
[bookmark: _Toc121286273][bookmark: _Toc146004304][bookmark: _Toc146004513][bookmark: _Toc121285981][bookmark: _Toc121286697][bookmark: _Toc121286582][bookmark: _Toc70154859]There are four registering modes in this attendance machine: face, fingerprint, password and card. Each user can register 10 fingerprints, 1 passwords, 1 face and 1 card(optional).
The manager registration is to authorize the manager to manage the operation. The registration method is the same as ordinary user registration, but the user privilege is selected as the senior administrator.
Note: The function of the induction card is non standard function, depending on its specific type.
[bookmark: _Toc10697][bookmark: _Toc70154860]1.1 Register
[bookmark: _Toc25057]1.1.1 Facial registration
Register → Register → Input work ID, name →Choose the face
 → OK → Enter 8 times → Success of registration 
[bookmark: _Toc8553]When you register your face, you need to place your face straight, and the machine will automatically recognize the current face. After 8 successful entries of different angle, the face will be saved to the device.
[bookmark: _Toc16581]1.1.2 Fingerprint registration
Register → Register → Input work ID, name → Registration of fingerprints → OK → Enter 3 times → Success of registration
[bookmark: _Toc70154863][bookmark: _Toc9345]1.1.3 Password registration
Register → Register → Input work ID, name → Select the password
 → OK → Input password → OK → Enter the password again → OK
[bookmark: _Toc70154866]The password length is 1-8 digits, and a user registers only one password.
[bookmark: _Toc30272]1.1.4 Induction card registration
Register → Register → Input work ID, name → Selection of card → OK → Please Swipe your card → OK 
[bookmark: _Toc146004514][bookmark: _Toc121286583][bookmark: _Toc121286274][bookmark: _Toc121286698][bookmark: _Toc146004305][bookmark: _Toc121285982][bookmark: _Toc70154869][bookmark: _Toc20380]1.2 View User
[bookmark: _Toc121286584][bookmark: _Toc146004515][bookmark: _Toc121286699][bookmark: _Toc70154870][bookmark: _Toc146004306][bookmark: _Toc121286275][bookmark: _Toc121285983]Register → View User → Choice of work ID  → OK → Select the options that need to be edited → OK .
View User can edit the data of registered users, backup fingerprints and modify user permissions.
[bookmark: _Toc18286]1.3 Delete User 
Register → Delete → Input work ID → OK → Select Delete→ OK
[bookmark: _Toc121286700][bookmark: _Toc121285984][bookmark: _Toc70154871][bookmark: _Toc121286585][bookmark: _Toc146004516][bookmark: _Toc121286276][bookmark: _Toc146004307][bookmark: _Toc17714]1.4 Query entry and exit record 
Register → View Log → Input work ID →  OK 
Note: We can only inquire about the entry and exit records of current month.
[bookmark: _Toc2411]Ⅱ Set communication
[bookmark: _Toc146004493][bookmark: _Toc121285959][bookmark: _Toc121286677][bookmark: _Toc121286560][bookmark: _Toc146004284][bookmark: _Toc121286251][bookmark: _Toc31910]2.1 Machine ID 
Set comm. → Machine ID → Input work ID（1-255） →  OK
[bookmark: _Toc14835]2.2 Baud Rate 
Set comm. → Baud rate → Select the speed of communication→ OK
The communication speed is optional 9600 or 19200 or 38400 or 57600 or 115200. The baud rate menu is used to set the speed of the communication between the attendance and the computer. The set must be consistent with the communication port of the PC manager, otherwise it can not communicate.
[bookmark: _Toc30975]2.3 IP Address
Set comm. → IP Address → Enter the IP address →  OK
The IP address of the machine needs to be in the same network segment as the computer IP address.
Note: Subnet mask, default gateway, port number, transmission, server IP address, server port number, refer to the IP address, use the choice key to enter, according to the network actual environment to input.

[bookmark: _Toc25388]Ⅲ Set time
Move the cursor to the time setting with the key up or down or enter the numeric key, enter the time needed to be set, and save it by OK. And Week is auto-calculated and no need to input.

[bookmark: _Toc18983]Ⅳ Device
[bookmark: _Toc121286704][bookmark: _Toc146004311][bookmark: _Toc146004520][bookmark: _Toc121286280][bookmark: _Toc121285988][bookmark: _Toc70154875][bookmark: _Toc121286589][bookmark: _Toc4710]4.1 General setting 
[bookmark: _Toc14597]4.1.1 Language
Device → General setting → Language → Choose the language required → OK 
Note: there are ten types of languages: Simplified Chinese, traditional Chinese, English and so on.
[bookmark: _Toc8768]4.1.2 Date Format
Device →  General setting → Date Format → Select the required format→ OK 
[bookmark: _Toc32181]4.1.3 Volume
Device →  General setting →Volume →Setting up the volume of the volume (1-8 optional) → OK
[bookmark: _Toc23190]4.1.4 Auto OFF
Device →  General setting→ Auto OFF → Set time shutdown time → OK
Note: 0 represents "no", "no" is switched off for timer shutdown, the time interval is 0-255, the unit is minute.
[bookmark: _Toc6180]4.1.5 Screen Saver
Device → General setting → Screen Saver→ Setting screen protection time→ OK
Note: the range of time is 1-255, and the unit is minute.
[bookmark: _Toc15639]4.1.6 Wiegand
Device → General setting → Wiegand → Set up Wiegand 26 or Wiegand 34 → OK
[bookmark: _Toc70154876][bookmark: _Toc146004312][bookmark: _Toc121286705][bookmark: _Toc121286281][bookmark: _Toc121285989][bookmark: _Toc146004521][bookmark: _Toc121286590][bookmark: _Toc26325]4.2 Logs 
[bookmark: _Toc19333]4.2.1 Arec WRN (Administrator record warning)
It is used to prompt when a administrator record reaches the limit of the attendance machine's storage limit. All the actions that are done by the administrator will be recorded as the administrator records.

Device → Logs → Arec WRN → Set number (range 0-255) → OK
[bookmark: _Toc13478]4.2.2 URec WRN (User Record Warning)
It is used to set up the number of attendance records before it reaches the limit of the memory capacity of the attendance machine. When it’s prompted, please use the software to collect the management records as soon as possible, and delete the data on the attendance machine to ensure that the new data can be stored.
Device → Logs → URec WRN → Set number (range 0-1500) → OK
[bookmark: _Toc15587]4.2.3 Re-verify
For setting two intervals of fingerprint confirmation, the unit is minute. After setting, the attendance data in the interval will not be recorded, and the sign has been signed at the same time. The default value of the factory is not.
Device → Logs → Re-verify → Set number (range 0-255) → OK
[bookmark: _Toc32191]4.3 Advanced
4.3.1  Delete ALL REC
Device → Advanced → Delete ALL REC → OK
[bookmark: _Toc285]4.3.2 Delete ALL REG
Device → Advanced → Delete ALL REG → OK
[bookmark: _Toc27937]4.3.3 Delete ALL data
Device → Advanced → Delete ALL data→ OK
[bookmark: _Toc12016]4.3.4 Default Setting
Device → Advanced → Default Setting → OK
This operation will restore all the parameters in the machine settings to the factory settings.
[bookmark: _Toc24418]4.4 Lock Control
[bookmark: _Toc5662][bookmark: _Toc70154878][bookmark: _Toc146004313][bookmark: _Toc146004522][bookmark: _Toc121286282][bookmark: _Toc121285990][bookmark: _Toc121286591][bookmark: _Toc121286706]4.4.1Time Setting
It is used to set different time period attributes and define different time periods.
Device → Lock ctrl. → Time Setting → Selected time period 1 → Choose the days of the week→ Set time period → OK 
[bookmark: _Toc23710]4.4.2Lock Register
Used to set up a group or time segment allowed by a user.
Device → Lock ctrl.  → Lock Register → Input the number that needs to be set → Set up the group and time → OK
[bookmark: _Toc16435]4.4.3Time Group Set
It is used to set different time periods in different groups, and define the time periods according to the time period item. For example, set group 1 to be time period 1.
Device → Lock ctr.l → Time Group Set → Select group → Set the required time period→ OK
[bookmark: _Toc19112]4.4.4Unlock Group
For set and combine different members from different groups, it can only be unlocked when all members are combined
Device → Lock ctrl. → Unlock Group → Select combination → Set the time segment of the group unlocking → OK
[bookmark: _Toc15451]4.4.5Unlock Time Delay
It is used to set how long the door can be closed after unlock verification The parameter range is set to 1-255, and the unit is second.
Device → Lock ctrl. → Unlock Time → Set number (range 1-255)→ OK
[bookmark: _Toc25082]4.4.6Lock Type Set
Device → Lock ctrl. → Lock Type Set → Setting door magnetic type and time delay
→ OK
[bookmark: _Toc20589]Note: The gate type is divided into three types: None, NC (Normal Close) and NO (Normal Open), and the default value of factory is none. The time delay range of the gate magnetic field is 1-10 seconds. If the gate type is set to a NC type, the gate time delay is set to 5 seconds. If the verification is successful, but the signal is not closed even after 5 seconds, an alarm signal will be issued.
[bookmark: _Toc14117]4.4.7Access Mode
Device → Lock ctrl. → Access Mode → Set unlock mode and confirm user qty.→ OK
[bookmark: _Toc4880]Note: There are two general modes: Yes or NO. The default values of the factory is No. The total number of confirmations is 1-5, and the factory default value is 1
[bookmark: _Toc763]Ⅴ、USB disk 
[bookmark: _Toc9510]5.1 All Rec. (Download all attendance data )
U disk → All Rec. → Insert the U disk → OK → Prompt download success

[bookmark: _Toc13965]5.2 Enr. Data (Download enrolled user data)
U disk → Enr. Data→ Insert the U disk → OK → Prompt download success
[bookmark: _Toc16338]5.3 Load Data (Upload user data)
U disk → Load Data → Insert the U disk → OK → Prompt download success

[bookmark: _Toc15368]Ⅵ System Info. 
Move the cursor to the machine information item with up and down keys. There are three sub menus.
1、Reg. Data：It is used to display all kinds of registration information of current users, including the number of registered users, the number of registered administrators, the number of facial registration, the number of fingerprint registration, the number of password registration, the number of card registration, and the specific information of attendance records.
[bookmark: _Toc70154879]2 Free Space Info：It is used to display the remaining capacity in the attendance machine, including the number of faces, the number of fingerprints, the number of cards, the number of passwords, and the number of attendance records
3 All Space Info：Display the total capacity of the attendance machine.
4 Product：It is used to show the manufacturer, the name of the equipment and the software version of the attendance machine, including the 7 contents of the manufacturer, the name of the equipment, the manufacturing date, the serial number, the version of the fingerprint algorithm, the firmware version and the firmware upgrade.

[bookmark: _Toc146004523][bookmark: _Toc121286592][bookmark: _Toc121286283][bookmark: _Toc146004314][bookmark: _Toc121286707][bookmark: _Toc121285991]
























[bookmark: _Toc19977][bookmark: _Toc121286708][bookmark: _Toc121286593][bookmark: _Toc121286284][bookmark: _Toc70154880][bookmark: _Toc146004315][bookmark: _Toc146004524][bookmark: _Toc121285992]Chapter 3 Enclosure
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[bookmark: _Toc353801910][bookmark: _Toc8620][bookmark: _Toc246234871][bookmark: _Toc22538]Illustration of Correct Fingerprint Pressing
[image: ]Flatly press fingerprint on U fingerprint scanner 
Try to press fingerprint center to the middle or a little upper of U scanner


[bookmark: _Toc246234872][bookmark: _Toc353801911][bookmark: _Toc15916][bookmark: _Toc27515][bookmark: _Toc243199791][bookmark: _Toc243208745][bookmark: _Toc243209343][bookmark: _Toc243206840][bookmark: _Toc243204145][bookmark: _Toc243206594][bookmark: _Toc243209274][bookmark: _Toc243209484][bookmark: _Toc243207047][bookmark: _Toc243212430][bookmark: _Toc243199327][bookmark: _Toc243208814][bookmark: _Toc243212223][bookmark: _Toc243206682][bookmark: _Toc243199396][bookmark: _Toc243198841][bookmark: _Toc243209205][bookmark: _Toc243212361][bookmark: _Toc243206978][bookmark: _Toc243204076][bookmark: _Toc243199258][bookmark: _Toc243206080][bookmark: _Toc243208644][bookmark: _Toc243209412][bookmark: _Toc243206751][bookmark: _Toc243212498][bookmark: _Toc243212154][bookmark: _Toc243212292][bookmark: _Toc243206909]Wrong Pressing Method
Too partial
Vertical
Too partial
Vertical
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· ： The recommended standing position (see below):
      [image: ]The distance between the recommended personnel and the equipment is 0.5 meters (1.55 m -1.85 meters for height range). The effect of the face image can be adjusted according to the equipment. When the face image is bright, it can move backward properly; when the face image is dark, it can move forward properly.

· Recommended facial expression and several facial expressions that affect the use of facial expressions:



· Recommended standing posture and several standing posture affecting the use effect:
Precautions: please keep natural facial expressions and standing posture during registration and use.
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[bookmark: _Toc29379]Wiring diagram of entrance guard
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